Learning Objectives

1. Understand the difference between system software and application software.
2. Explain the different functions of an operating system and discuss some ways that operating systems enhance processing efficiency.
3. List several ways in which operating systems differ from one another.
4. Name today’s most widely used operating systems for personal computers and servers.
5. State several devices other than personal computers and servers that require an operating system and list one possible operating system for each type of device.

6. Discuss the role of utility programs and outline several tasks that these programs perform.

7. Describe what the operating systems of the future might be like.
Overview

• This chapter covers:
  – Differences between system software and application software
  – Functions of and general differences between operating systems
  – Specific operating systems most widely used today
  – Functions of and various types of utility programs
  – A look at future of operating systems
System Software vs. Application Software

- **System Software**
  - The operating system and utility programs that control a computer system and allow you to use your computer
  - Enables the boot process, launches applications, transfers files, controls hardware configuration, manages files on the hard drive, and protects from unauthorized use

- **Application Software**
  - Programs that allow a user to perform specific tasks on a computer
    - Word processing, playing games, browsing the Web, listening to music, etc.
The Operating System

- Operating System
  - A collection of programs that manage and coordinate the activities taking place within a computer
  - Acts as an intermediary between the user and the computer and between the application programs and system hardware
Functions of an Operating System

- Interfacing with Users (typically via a GUI)
- Booting the Computer
  - Loads essential part of operating system (kernel) into memory
  - Reads opening batch of instructions
  - Determines hardware connected to computer
- Configuring Devices
  - Device drivers are often needed; can be reinstalled if needed
  - Plug and Play devices are recognized automatically
Functions of an Operating System

• Managing Network Connections
  – Manages wired connections to home or office network
  – Manages wireless connections at home, school, work, or on the go

• Managing and Monitoring Resources and Jobs
  – Makes resources available to devices and programs
  – Monitors for problems and attempts to correct those that arise
  – Schedules jobs
    • Jobs to be printed
    • Files to be retrieved from hard drive
Functions of an Operating System

• File Management
  – Keeps track of stored files on computer so they can be retrieved when needed
    • Files usually viewed in a hierarchical format
• Security
  – Passwords
  – Biometric characteristics
  – Firewalls
Functions of an Operating System

**FIGURE 5-5**
A sample hard drive organization.

PATHS
A path shows the folders you must travel through to get to a particular file. C:\My Documents\Letters\Mary, for instance, is the path to Mary’s letter.
Processing Techniques for Increased Efficiency

• Multitasking
  – The ability of an operating system to have more than one program (task) open at one time
    • CPU rotates between tasks
    • Switching is done quickly
    • Appears as though all programs executing at the same time
Processing Techniques for Increased Efficiency

- Multithreading
  - The ability to rotate between multiple threads so that processing is completed faster and more efficiently
  - Thread
    - Sequence of instructions within a program that is independent of other thread
- Multiprocessing and Parallel Processing
  - Multiple processors (or multiple cores) are used in one computer system to perform work more efficiently
  - Tasks are performed sequentially
Processing Techniques for Increased Efficiency

**SEQUENTIAL PROCESSING**
Tasks are performed one right after the other.

<table>
<thead>
<tr>
<th>Single CPU</th>
</tr>
</thead>
<tbody>
<tr>
<td>Begin word processing document spell check</td>
</tr>
</tbody>
</table>

(multitasking and multithreading)

**SIMULTANEOUS PROCESSING**
Multiple tasks are performed at the exact same time.

<table>
<thead>
<tr>
<th>CPU 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Begin word processing document spell check</td>
</tr>
<tr>
<td>Load Web page</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>CPU 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Begin Web page loading</td>
</tr>
</tbody>
</table>

(multiprocessing)

(parallel processing)

**FIGURE 5-7**
Sequential vs. simultaneous processing.

Understanding Computers: Today and Tomorrow, 15th Edition
Processing Techniques for Increased Efficiency

• Memory Management
  – Optimizing the use of main memory (RAM)
  – Virtual memory
    • Memory-management technique that uses hard drive space as additional RAM
Processing Techniques for Increased Efficiency

• Buffering and Spooling
  – Buffer
    • Area in RAM or on the hard drive designated to hold data that is used by different hardware devices or programs
  – Buffering or Spooling
    • Placing items in a buffer so they can be retrieved by the appropriate device when needed
Differences Among Operating Systems

• Command Line Interface
  – Require users to input commands using the keyboard

• Graphical User Interface
  – Graphics based interface
  – Used by most operating systems
Differences Among Operating Systems

• Categories of Operating Systems
  – Personal (Desktop) Operating Systems
    • Designed to be installed on a single computer
  – Server (Network) Operating Systems
    • Designed to be installed on a network server
    • Client computers still use a personal operating system
    • Server operating system controls access to network resources
  – Mobile and embedded operating systems are also common
Differences Among Operating Systems

1. The client software provides a shell around your desktop operating system. The shell program enables your computer to communicate with the server operating system, which is located on the network server.

   **Client shell**
   
   - Desktop operating system
   - Application software
     - Your print job

2. When you request a network activity, such as printing a document using a network printer, your application program passes the job to your desktop operating system, which sends it to the client shell, which sends it on to the server operating system, which is located on the network server.

   Desktop computer running Windows and client software for the server operating system being used.

3. The server operating system then lines up your job in its print queue and prints the job when its turn comes.

   Network server running a server operating system.

   **PRINT QUEUE**
   
   - Job A
   - Job B
   - Job C
   - Your print job

4. Your print job

**FIGURE 5-11** How network operating systems work.
Differences Among Operating Systems

• The Types of Processors Supported
  – Desktop, mobile, server processors
  – 32-bit or 64-bit CPUs

• Support for Virtualization and Other Technologies
  – New types of buses
  – Virtualization
  – Mobility
  – Security concerns
  – Power-consumption concerns
  – Touch and gesture input
  – The move to cloud
Quick Quiz

1. Which of the following processing techniques allows a computer to work with more than one program at a time?
   a. Parallel processing
   b. Virtual memory
   c. Multitasking

2. True or False: Most operating systems today use a command line interface.

3. __________ is the task included with operating systems that allows you to keep track of the files stored on a PC.

Answers:
1) c; 2) False; 3) File management
Internet Monitors

– Locked-down system with restricted functionality
– Essentially just a monitor that provides Internet access
– Users can run apps but can’t change settings so easier for businesses to provide Internet access without much maintenance
• DOS (Disk Operating System)
  – DOS traditionally used a command-line interface
  – Dominant operating system in the 1980s and early 1990s
  – PC-DOS
    • Created originally for IBM microcomputers
  – MS-DOS
    • Created for use with IBM-compatible computers
  – Can enter DOS commands in Windows
DOS

**FIGURE 5-12**

DOS. Even though DOS has become technologically obsolete, Windows users can still issue DOS commands via the Command Prompt.
Windows

- The predominant personal operating system developed by Microsoft Corporation
- Windows 1.0 through Windows Vista
  - Windows 1.0 released in 1985
    - Windows 1.0 through Windows 3.x were operating environments for DOS
  - Windows 95, Windows 98, and Windows ME
  - Designed for personal computers
Windows

• Windows NT (New Technology)
  – First 32-bit version of Windows designed for high-end workstations and servers
  – Replaced by Windows 2000

• Windows XP
  – Replaced both Windows 2000 and Windows Me

• Windows Vista
  – Replaced Windows XP
  – Introduced the Aero interface and Sidebar feature
Windows

- Windows 7
  - Released in late 2009
  - Home Premium (primary version for home users)
  - Professional (primary version for businesses)
  - Libraries feature gives you virtual folders

- Windows 8
  - Current version of Windows
  - Designed to be used with smartphones, desktop computers, with or without a keyboard or mouse
  - Supports multi-touch input
  - Includes Start screen, tiles, and charms bar
Windows

**FIGURE 5-14**

Windows 8.
Windows

– Windows Server
  • The version of Windows designed for server use
  – Windows Server 2012 is the latest version
  – Supports both virtualization and cloud computing

– Windows Home Server
  • Preinstalled on home server devices
  • Designed to provide services for a home network
  • Can be set up to back up all devices in the home on a regular basis
Mac OS

• Mac OS
  – Proprietary operating system for computers made by Apple Corporation
  – Based on the UNIX operating system
  – Originally set the standard for graphical user interfaces
• Mac OS X Family
  • Mac OS X Mountain Lion and Mac OS X Mavericks
  • Mac OS X Server
    • Server version of Mac OS X
Mac OS

**FIGURE 5-15**
Mac OS X Mavericks.
UNIX

- Operating system developed in the late 1960s for midrange servers
- Multiuser, multitasking operating system
- More expensive, requires high level of technical knowledge; harder to install, maintain, and upgrade
- “UNIX” initially referred to the original UNIX operating system, now refers to a group of similar operating systems based on UNIX
- Single UNIX Specification
  - A standardized UNIX environment
Linux

• Linux
  – Developed by Linus Torvalds in 1991—resembles UNIX but was developed independently
  – Is open-source software; has been collaboratively modified by volunteer programmers all over the world
  – Originally used a command line interface, most recent versions use a GUI
  – Strong support from mainstream companies, such as IBM, NVIDIA, HP, Dell, and Novell
  – Individuals and organizations are switching to Linux and other open source software because of cost
Linux

Figure 5-16
Linux. This version is Ubuntu, one of the most widely-used Linux operating systems.
Chrome OS

• Chrome OS
  – The first cloud operating system
  – Essentially is the Chrome Web browser redesigned to run a computer, in addition to accessing Web resources
  – Replaces traditional desktop operating systems
  – Is currently only available preinstalled on Chrome devices
Quick Quiz

1. Which of the following is the most recent personal version of Windows?
   a. Windows 8
   b. Windows Leopard
   c. Windows XP

2. True or False: Linux is an open source operating system available for free via the Internet.

3. The operating system most commonly used on Apple personal computers is __________.

Answers:
1) a; 2) True; 3) Mac OS
Technology and You Box

Smart Cars

– Use of computers in cars has skyrocketed
– Self-driving systems and self-parking systems
– Lane departure and blind spot detection systems
– Windshield displays
– Collision warnings and auto brake systems
– Keyless entry and ignition systems
– Distraction-prevention systems
– Safety of gadgets is a concern
Operating Systems for Mobile Devices

• Windows Phone 8, Windows RT, and Windows Embedded
  – Windows Phone
    • Latest version of Windows designed for smartphones
    • Windows Phone 8 is based on the Windows 8 operating system
  – Windows RT
    • Designed for tablet use
  – Windows Embedded
    • Designed primarily for consumer and industrial devices that are not personal computers
Operating Systems for Mobile Phones and Other Devices

- Android
  - Linux-based operating system created with current mobile device capabilities in mind
  - Can create applications that take full advantage of all the features a mobile device has to offer
  - Open platform
  - Current version is Android 4.3, also known as Jelly Bean
  - Devices support multitasking, multiple cores, NFC mobile payment transactions, Internet phone calls
Operating Systems for Mobile Phones and Other Devices

FIGURE 5-18
Android is used with both phones (left) and media tablets (right).
– iOS
  • Designed for Apple Mobile phones and mobile devices
  • Current version is iOS 7
  • Supports multitasking
  • Includes Safari Web browser, the Siri intelligent assistant, *Facetime* video calling, *AirDrop* to send items to others, and apps for email, messaging, music, and search
Operating Systems for Mobile Phones and Other Devices

FIGURE 5-19
iOS.

Courtesy Apple
Operating Systems for Mobile Phones and Other Devices

– Blackberry OS and Blackberry PlayBook OS
  • Designed for Blackberry devices

– Mobile Linux
  • Other mobile operating systems based on Linux besides Android and iOS
  • Ubuntu, webOS, Firefox OS, and Tizen
Operating Systems for Larger Computers

- Larger computers sometimes use operating systems designed solely for that type of system
- IBM’s z/OS is designed for IBM mainframes
- Windows, UNIX, and Linux are also used with servers, mainframes, and supercomputers
- Larger computers may also use a customized operating system based on a conventional operating system
Weather Forecasting in the Alps

- Weather forecasting is difficult in the Alps due to complex topography and intense precipitation
- Supercomputer Piz Daint is Linux based, uses CPUs and GPUs, and runs at 750 teraflops
- Can run 30 weather forecasting models simultaneously
- Cooled with water from a nearby lake
Utility Programs

- Utility Program
  - Software that performs a specific task, usually related to managing or maintaining the computer system
  - Many utilities are built into operating systems (for finding files, viewing images, backing up files, etc.)
  - Utilities are also available as stand-alone products and as suites

**FIGURE 5-20** Utility suites. Utility suites contain a number of related utility programs.
File Management Programs

- Enable the user to perform file management tasks, such as:
  - Looking at the contents of a storage medium
  - Copying, moving, and renaming files and folders
  - Deleting files and folders
- File management program in Windows 8 is File Explorer
  - To copy or move files, use the Home tab to copy (or cut) and then paste
  - To delete files, use the Delete key on the keyboard or the Home tab
File Management Programs

Use the Home tab to access the most frequently used commands, such as to copy files and folders.

The Address bar shows the current location.

Use the View tab to specify how the items in the right pane are displayed.

Use the New folder button to create a new folder in the current location.

Use the Back button to go to the previous location.

Click an item in the left pane to display its contents in the right pane.

The Navigation pane contains resources you can use, including Libraries, drives, and network resources.

Enter keywords to search for a folder or file that matches the criteria you supply.

Double-click a folder to open it.

Double-click a document to open it in its associated program.

FIGURE 5-21
Using File Explorer to look at the files stored on a computer.
How It Works Box

Sending to the Cloud

- Add cloud locations to the Send To menu
- Google Drive, SkyDrive, etc.

Step 1: Right-click an item to display the Send to menu.

Step 2: To open the SendTo folder, type this command in the Address bar.

Step 3: Copy your desired locations (such as your SkyDrive or Google Drive favorites) to the SendTo folder.

Step 4: The new locations will now appear on the Send to menu.
Utility Programs

• Search Tools
  – Designed to search for documents and other files on the user’s hard drive
    • Windows 8 has Search charm to search for files, apps, and Store items
  – Are often integrated into file management programs
  – Third-party search tools are also available
• Diagnostic and Disk Management Programs
  – Diagnostic programs evaluate your system and make recommendations for fixing any errors found
  – Disk management programs diagnose and repair problems related to your hard drive
Utility Programs

• Uninstall and Cleanup Utilities
  – Uninstall utilities remove programs from your hard drive without leaving bits and pieces behind
  – Important to properly uninstall programs, not just delete them
  – Cleanup utilities delete temporary files
    • Files still in Recycle Bin
    • Temporary Internet files
    • Temporary installation files
Utility Programs

• File Compression Programs
  – Reduce the size of files to optimize storage space and transmission time
  – Both zip and unzip files
  – WinZip (Windows users) and Stuffit (Mac users)

• Backup and Recovery Utilities
  – Make the backup and restoration process easier
  – Creating a backup means making a duplicate copy of important files
    • Can use a recordable or rewritable CD or DVD disc, a USB flash drive, or an external hard drive
Utility Programs

– Good backup procedures are critical for everyone
  • Individuals should back up important documents, e-mail, photos, home video, etc.
  • Performing a backup can include backing up an entire computer (so it can be restored at a later date)
  • Can do the backup manually or use backup utility programs (stand alone or those built into operating systems)
  • Can also backup individual files are they are modified
Utility Programs

FIGURE 5-26
The Windows File History program.
Utility Programs

• Antivirus, Antispyware, Firewalls, and Other Security Programs
  – Security Concerns
    • Viruses, spyware, identity theft, phishing schemes
  – Security programs protect computers and users and it is essential that all computer users protect themselves and their computers
    • Antivirus programs
    • Antispyware programs
    • Firewalls
    • Many are included in Windows and other operating systems
The Future of Operating Systems

• Will continue to become more user-friendly
• Will eventually be driven primarily by a voice interface, touch, and/or gesture interface
• Likely to continue to become more stable and self-healing
• Will likely continue to include security and other technological improvements as they become available
• Will almost certainly include improvements in the areas of synchronizing and coordinating data and activities among a person’s various computing and communicating devices
• May be used primarily to access software available through the Internet or other networks
Quick Quiz

1. Which of the following is the type of utility program used to make a file smaller for transfer over the Internet?
   a. Uninstall program
   b. Antivirus program
   c. File compression program

2. True or False: A file management program can be used to see the files located on a storage medium.

3. A(n) __________ is a duplicate copy of one or more files that can be used if there is a problem with the original files.

Answers:
1) c; 2) True; 3) backup
Summary

• System Software vs. Application Software
• The Operating System
• Operating Systems for Personal Computers and Servers
• Operating Systems for Mobile Phones and Other Devices
• Operating Systems for Larger Computers
• Utility Programs
• The Future of Operating Systems